Paint Shop Pro 7.04

Try & Buy Version
Release Notes

Thank you for evaluating Jasc® Paint Shop Pro™ 7! Our newest release of Paint Shop Pro is packed with
powerful new features and enhancements, including Jasc Animation Shop™ 3. Once you begin using
these programs, we think you will see just how easy it can be to create Web graphics and enhance digital
photos.

Please see the license agreement included in this document for limitations on the duplication and
distribution of this software and other important information.
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What is a Try & Buy Version?

A Try & Buy version lets a person try out a computer program before buying it. While Try & Buy versions
are copyrighted, and the copyright holder retains all rights, the author specifically grants the user the right
to evaluate and distribute the program with limited exceptions.

After using the Try & Buy version for a defined evaluation period, the user must purchase a licensed copy
of the program or remove the Try & Buy version from his or her system.

Changes in Paint Shop Pro 7.04
Preview windows are faster in several program dialog boxes.

¢ Paint Shop Pro 7 now processes OLE embedded documents from Paint Shop Pro versions 5 and 6.
It is no longer necessary to leave these versions installed to edit embedded Paint Shop Pro 5 and 6
objects.

e Added an "Apply Smoothing" option to the WMF/Import tab of the File Format Preferences dialog box
to improve the quality and accuracy of some imported vector data.

e When using the Gamma Correction adjustment dialog, proofing an image before the right preview
window updated could apply incorrect modifications and fail to revise the command history. This issue
is fixed for Gamma Correction and other affected commands.

e The program no longer calls all installed format filters when it cannot identify a file type. The change
eliminates the "Cannot open PhotoCD Image" message some users encountered when using the
browser.

e The application no longer stalls at start-up if resources (e.g., gradients) or their designated folders are
unavailable.



Irrelevant characters are discarded from plug-in category names to ensure proper sorting.

All selected files obey the "Files of type" drop-list selection when using the File Open dialog box.
Opening an image from outside of the application (e.g. using drag-and-drop) when Multiple Image
Printing is active will no longer cause the wrong menubar to appear.

The following file format support updates also affect Animation Shop 3.04 (see also "Changes in
Animation Shop 3.04")

When opening Portable Network Graphics (PNG) containing an alpha channel, the channel content is
read as transparency. Previous versions treated a PNG alpha channel as a Paint Shop Pro alpha
channel. PNG alpha channels will also display as transparent areas in the browser and Open dialog
box thumbnail previews as a result of this change.

ASCII versions of PPM/PGM/PBM containing unusual white space characters can be read more
reliably.

Resolved issues with reading multi-page or poorly compressed LZW TIFFs.

Increased the supported width limit on uncompressed TIFFs to 32,768 pixels.

Fixed several other minor issues with text size, formatting, object placement, bitmap palettes, multi-
byte character sets, and single or no pixel lines in metafiles.

Multiple embedded bitmaps can now be read from a metafile.

Corrected an issue where some CGM files displayed as a blank image because bad color values for
lines, edges, and fills (brushes) displayed in the default background color (white). The program now
assigns the default foreground color (black) to this content in accordance with the file format
specification.

Reduced JPEG compression for thumbnails to improve display quality.

Added support for bitmaps with negative heights and fixed a problem reading OS/2 version 2.x
bitmaps.

Changes in Paint Shop Pro 7.02
This version has resolved the following reported issues:

The Smudge and Push modes of the Retouch brush now function properly.

The Moiré Pattern Removal filter processes grey scale images correctly.

When creating floating text with "Standard text" settings (solid color fill only), the text is now filled
correctly with the selected color.

The Clarify filter has been fixed to address cases where it would improperly lighten dark image areas.
Attempting to use a texture or pattern with a extremely large or small aspect ratio (image width
divided by image height) will no longer cause a program error.

When changing a setting in certain adjustments and filters and then quickly pressing the <Enter> key
to apply the command, the program will now perform the command with the proper settings. This
issue was known to affect the Colors>Gamma Correction command.

Object handles on selected vector text will no longer disappear after the text has been edited.

The "Browse with Paint Shop Pro 7" shell context menu command now properly views the contents of
a drive's root directory.

Changes in Paint Shop Pro 7.01

We've made several changes to the program to improve overall performance and address known issues
reported to us by our customers. The list below cites the most significant changes in this version of the
program.

Program Enhancements

Layer Palette performance has been significantly improved for faster layer and object management.
These performance enhancements are most evident when using the Layer Palette to manipulate
images containing several layers and/or vector objects.

A progress indicator has been added to program effects when generating previews or proofing
changes.



The Image Mapper and Image Slicer tools have been updated for easier slice/map boundary
selection and definition. Boundary selection requires less precise positioning of the cursor, and the
windows now scroll as necessary when defining boundaries.

The Clarify and Moiré Pattern Removal photo effects have been updated for better performance.

The Average, Median, Edge and Texture Preserving Smooth, Manual Color Correction, Salt & Pepper
Filter, Histogram Adjustment, and all automatic photo enhancement filters now support transparent
layers.

The Retouch mode selection droplist is now located on the first tab of the Tool Options palette for
easier mode selection.

The “Sample merged” option is now available when using the Retouch tool with the Sharpen, Soften,
and Emboss retouch modes.

The “Paint Shop Pro Folders” special folder options in the Browse for folder dialog box now include a
listing for the Shapes folder

A “Create new folder” command has been added to the File menu when a browser window is active.
The command will allow the user to create a new folder as a subdirectory of the folder currently being
viewed by the browser. A button may be added to the Browser toolbar for this command if desired.
When performing multiple screen captures, the minimum window size of each capture has been
increased to ease identification of small captures, such as individual menu items.

Fixes

A display issue causing the Effects menu to remain on screen after use has been resolved.

When cropping an irregular selection area, the area outside of the selection is now either filled with
the current background solid color (when performed on a background layer) or rendered transparent
(when performed on a raster layer).

An issue that could cause an application error when using the Proof and Auto Proof options in the
Text Entry dialog on a background layer has been resolved.

The Rotate command operates correctly after moving a layer containing a mask while in Mask Edit
mode.

The Histogram and Overview windows are properly updated after performing a crop.

When creating or resizing a crop marquee using the mouse, the ruler operates in the same manner
as the Selection tool by displaying the affected area as a dashed line.

Plug-in filters that have been properly removed from paths used by the program will no longer be
listed as available plug-in filters or file import/export options.

DPI information is correctly passed to file export plug-in filters

The Sculpture and Texture effects correctly preview and apply rectangular patterns.

The Colors>Adjust>Hue/Saturation/Lightness command processes Lightness value changes properly.
The Page Curl effect will no longer leave white spots at the edge of the curl.

When using the Save, Save As, and Preview commands, the Image Mapper properly processes
vertical map boundaries when they do not extend across the entire map grid.

The Image Slicer will no longer generate an error when using the Grid tool and clicking on an area
outside of the document in the preview window.

Information in the “Target” field is now retained when saving Image Slicer settings.

Vector objects are properly redrawn when they are on different layers and their properties are
collectively modified after being selected with the Object Selector tool.

Attempting to group existing vector object groups will no longer cause an application error.

Gradient fill colors are retained when changing vector object properties when the current foreground
or background solid colors differ from the active colors at the time the object was created.

Nested vector group names are properly retained.

When pasting a new layer, a display problem that would cause a second instance of the pasted data
to temporarily appear has been corrected.

Layer group values are retained when layer positions are modified using the Layer Palette.

The JPEG and GIF Wizards output properly when run with their default options.

When using the Save As command to save in JPEG format, designating a new path and filename,
then launching the JPEG optimizer, the new path and filename are retained when the optimizer
returns to the Save As dialog box.



e A problem that could prevent the browser from displaying thumbnails of supported file types when the
browser’s cache file was read-only has been corrected.

¢ Image size and memory information is no longer clipped off the right edge of the Status Bar when
running the program in a normal window at a screen resolution of 800 x 600.

e When the position of the previewed area is changed using the four-arrowhead button in affected
program dialog boxes, the change is now retained when using the Zoom In/Out controls.

¢ Rulers are now properly synchronized when images are viewed at negative zoom levels.

e The brush and Scratch Remover tools now function properly after closing some instances of the Page
Setup or Multiple Image Printing views.

e 1-and 4-bit images are properly processed and previewed when used as a pattern by program tools
and effects.

e Several minor issues with using Undo to discard changes to vector content and masks have been
corrected.

Changes in Paint Shop Pro 7.0

We have added several great new features and enhancements to Paint Shop Pro 7.0. The most
significant product changes are listed below. For a more detailed explanation of these features, please
consult the Paint Shop Pro 7 Help file.

Photo Enhancement

Automatically adjust color balance, contrast, and saturation.

Remove red-eye on people and animals.

Restore damaged photos with Scratch Removal Tool.

Adjustable Histogram enhances details without loss of information.

Automatically improve video, scanned, and overly compressed images.

Automatically remove noise, scratches, dust, or specks and improve crispness and impact.

Business/Home Graphics

Vector shapes, lines, and text now support gradients, textures, and patterns on the stroke and fill.
Brushes now support gradients, textures, and patterns.

Align, distribute, arrange, group and resize vector objects.

Create and save custom-styled lines with dots, dashes, and end-caps.

Create and save custom shapes for reuse.

Position more precisely with snap-to grids and guides.

Experiment with over 25 new artistic and lighting special effects.

Web Design

e Create professional-quality GIF animations with Animation Shop 3.

e Preview graphics in various Web file formats in up to three browsers.

e New PNG optimizer for high Web performance.

¢ An Image Mapper and Image Slicer with JavaScript rollover creation support.

Productivity & Ease of Use

¢ Repeat last command feature.

e Save and retrieve workspaces to manage projects.

¢ Quickly identify and select with thumbnail previews of Picture Tubes, Gradients, Textures, Patterns,
and Preset Shapes.

¢ Navigate easier while in Zoom mode with the Overview Window Palette.

¢ Protect critical work with customizable Auto-Save.

e Easily view your adjustments with proofing, autoproofing, and reset options on most dialogs.

Changes in Animation Shop 3.04

Several changes to Paint Shop Pro 7.04 also affect this version of Animation Shop. Please review the
"Changes in Paint Shop Pro 7.04" section for a list of these changes.

e The correct icons now appear for the corresponding File menu commands.



Changes in Animation Shop 3.02

A duplicate sample animation file (Insert&Apply.mng) has been removed from the program
installation.

Changes in Animation Shop 3.01
The list below cites the most significant changes in this version of the program.

An issue that could cause program instability when attempting to open corrupted FLI and FLC files
has been corrected.

Canceling the Optimization Wizard will no longer return an application error.

The Help button in the Open dialog box now displays the correct topic.

A warning message dialog box now appears when attempting to open a MNG file that contains
unsupported features. The program currently supports MNG-LC.

Changes in Animation Shop 3.0

We have added several great new features and enhancements to Animation Shop 3.0. The most
significant product changes are listed below. For a more detailed explanation of these features, please
consult the Animation Shop 3 Help file.

Integration of the Paint Shop Pro browser into Animation Shop, providing an intuitive manner for you
to select image files to include in animations and open in the application.

An Onionskin Preview mode allows you to preview an overlay of frames before and after the current
frame for more precise animation editing and creation.

A variety of frame and animation modification options have been added, including frame rotation
options, a Mover tool, a color replacement command and floating text and image placement.

New animation preview options, including enhancements to the Optimization Wizard and the ability to
preview the current animation in your selected Web browser.

A new Morph transition, for enhanced fade effects using customizable key points between frames.

A new toolbar with VCR-style controls that allow you to play, fast-forward and rewind your animation.
Support for reading MPEG-format video files.

Enhanced integration between Animation Shop and Paint Shop Pro, including enhanced multiple-
layer export and the ability to export all or part of an animation as a tube to be used with Paint Shop
Pro.

Obtaining and Installing Direct Digital Camera Support

Paint Shop Pro provides direct support for many popular digital cameras. A separate installation program
for this support is included with the CD-ROM version of Paint Shop Pro. This installation program is also
available for download from our Web site at www.jasc.com for customers who purchased the electronic
download version of Paint Shop Pro. A list of supported cameras is also available at this location.

The CD-ROM version of Paint Shop Pro will create a Start Menu shortcut for the digital camera support
installer in the Jasc Software\Utilities folder during program installation.

To install direct digital camera support, proceed as follows:

1.

2.

3.

4.

If you purchased an electronic download version of Paint Shop Pro, download the Jasc Software
Digital Camera Support setup program.

Run the camera installation program by selecting the "Jasc Digital Camera Support" shortcut in the
Jasc Software\Utilities folder of the Start Menu (CD-ROM version) or double clicking on the file you
downloaded in step 1.

Select the appropriate camera from the list of available devices. By default, no cameras are selected
in the setup program. To select the desired camera, click on the disk icon to display a menu of
available installation options, then click the "This feature will be installed on local hard drive" option.
The installation program will install the necessary files for accessing the selected camera(s) and close
after the installation is complete.



5. Once the desired support is installed, you can configure and access the camera using the
Import>Digital Camera commands on Paint Shop Pro's File menu.

Note: Kodak DC120 and DC2xx model cameras are supported internally and do not require this
component.

Obtaining Technical Support
Technical support for Paint Shop Pro 7 and Animation Shop 3 can be obtained from:
Jasc Software, Inc.

PO Box 44997
Eden Prairie, MN 55344 USA

Voice: (952) 930-9171
Fax: (952) 930-9172
Internet:
Paint Shop Pro: psp7evalsup@jasc.com
Animation Shop: anm3evalsup@jasc.com
Web: www.jasc.com

International customers can also contact their regional master representative for technical support. To
obtain contact information for your regional master representative, please see the International Master
Representatives List page on our Web site at http://www.jasc.com/world.asp or contact our Technical
Support department using the information provided above.

Software License and Limited Warranty

This Jasc End-User License Agreement ("EULA") is a legal agreement for the Jasc Software Product in
which this EULA is contained, which includes computer software and may include associated media,
printed materials, and "online" or electronic documentation (collectively the "Software Product"), between
you and Jasc Software, Inc. ("Jasc"). By installing, copying, or otherwise using the Software Product, you
agree to be bound by the terms of this EULA. You must indicate your agreement to be bound by the terms
of this EULA by pressing the "l ACCEPT" button on the Software Product's installation program, or else
you will not be able to install the Software Product. If you do not agree to the terms of this EULA, you
may not install or use the Software Product; you may, however, within 30 days of your initial purchase of a
copy of the Software Product, return the entire copy of the Software Product (including all computer
media, packaging and documentation) either to Jasc's Customer Service department or to the retailer
from which you purchased the Software Product, for a refund of the amount indicated by your sales
receipt for the Software Product, in which event your rights under this EULA are immediately terminated.
If you are installing the Software Product on a computer that is not owned by you, you are bound to the
terms of this EULA both in your individual capacity and as an agent of the owner of the computer, and
your actions will bind the owner of the computer. You represent and warrant to Jasc that you have the
capacity and authority to enter into this Agreement on your own behalf as well as on behalf of the owner
of the computer the Software Product is being installed upon. For purposes of this EULA, the "owner" of a
computer is the individual or entity that has legal title to the computer or that has the possessory interest
in the computer if it is leased or loaned by the actual title owner.

COPYRIGHT. The Software Product is protected by copyright laws and international copyright treaties, as
well as other intellectual property laws and treaties. All title and copyrights in and to the Software Product
(including but not limited to any images, photographs, animations, video, audio, music, text, and "applets"
incorporated into the Software Product) are owned by Jasc or its suppliers.

GRANT OF LICENSE. The Software Product is licensed, not sold. Subject to the condition that you are in
compliance with the terms of this EULA: (a) you may install and use one copy of the Software Product, or
any prior version for the same operating system, on a single computer for use by a single simultaneous
operator; and (b) you may install a single copy of the Software Product, strictly for your own personal use,



on one portable computer owned by you. No other use, copying or distribution of the Software Product is
permitted. You may not rent the Software Product, nor may you offer use of it to others through a service
bureau or application service provider. If you are installing this copy of the Software Product as an
upgrade, update, patch or enhancement of a prior release of the same Software Product which was
installed on the same computer, your rights under the prior license agreement for the Software Product
are terminated, and all of your use of the Software Product (including its prior versions) are solely under
the terms of this license agreement.

LIMITATIONS. Except to the extent such a restriction is unenforceable under local law, you may not reverse
engineer, decompile, or disassemble the Software Product. The Software Product is licensed as a single
product, and its component parts may not be separated for use on more than one computer. You may not
modify, amend, or create derivative works of the Software Product.

TeERM. If the Software Product that was distributed to you was labeled as an EVALUATION VERSION or
TRY & BUY VERSION (or its functional equivalent) (an "Evaluation Version"), the license granted under
this EULA commences upon the installation of the Software Product and is effective for the longer of 30
days following the date you install the Software Product or the first 20 uses (the "Evaluation Term").
Evaluation Version Software Products may include software code intended to disable their functionality
after the expiration of the Evaluation Term. You may take no actions to circumvent the operation of such
disabling code, and you accept all risks that might arise from such disabling code. If the Software
Product was not distributed as an Evaluation Version, or if you converted an Evaluation Version
installation of the Software Product to a non-Evaluation Version of the Software Product by authorised
use of the conversion mechanism provided with the Software Product (in each case either being or
resulting in a "Full-License Version"), the licenses granted under this EULA commence upon the
installation of the Software Product and are effective in perpetuity unless terminated per the terms of this
Agreement.

TERMINATION. Upon the expiration of the Evaluation Term (if any), your rights under this EULA terminate
automatically without notice from Jasc. Without prejudice to any other rights, Jasc may terminate this
EULA or your rights under this EULA at any time if you fail to comply with the terms and conditions of this
EULA. Upon termination of your rights under this EULA for any reason, or upon termination of the EULA
itself, you must destroy all copies of the Software Product and all of its component parts in your
possession (including all component parts, the media and printed materials, any prior versions, and this
EULA). The terms of this paragraph shall survive any termination of this EULA.

TRANSFER. You may permanently transfer all of your rights under this EULA (except if your rights are in
an Evaluation Version), provided you retain no copies, you transfer all copies of the Software Product
(including all component parts, the media and printed materials, any prior versions, and this EULA), and
the recipient agrees to be subject to the terms of this EULA. Upon the occurrence of such a transfer, your
rights under this EULA terminate immediately.

LimiTED WARRANTY. The warranties and disclaimers described in this paragraph are collectively the
"Limited Warranty". Jasc warrants to you (and only you) that the Software Product will perform
substantially in accordance with the accompanying documentation (if any) for a period of ninety (90) days
from the date of original purchase of a license to the Software Product from an authorised retailer or
directly from Jasc (or the date you have obtained authorization from Jasc or an authorised retailer to
convert an Evaluation Version to a Full-License Version) (in each case the "Purchase Date"). Implied
warranties on the Software Product, to the extent required by applicable law, are limited to ninety (90)
days from the Purchase Date. Some states do not allow limitations on how long an implied warranty lasts,
so the above limitation may not apply to you. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, JASC
AND ITS SUPPLIERS DISCLAIM ALL OTHER WARRANTIES AND CONDITIONS WITH REGARD TO OR ARISING OUT OF
THE SOFTWARE PRODUCT, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NON-INFRINGEMENT AND/OR ACCURACY OF
INFORMATION. The Limited Warranty is void if failure of the Software Product has resulted from accident,
abuse, misapplication, use of the Software Product other than as described in the documentation issued
by Jasc, use of the Software Product in combination with other Software Products that are not described



as compatible in the documentation issued by Jasc, or your breach of the terms of this EULA. This
warranty gives you specific legal rights, and you may also have other rights which vary from State to
State. No individual (except a duly authorised officer of Jasc) and no reseller or retailer has any authority
to amend or add to any of the above representations and disclaimers.

YOUR REMEDY. Your exclusive remedy for any breach of the Limited Warranty is for you to give us notice
of the breach by returning to Jasc (at the address shown below) a copy of your purchase receipt for your
copy of the Software Product and a description of the alleged breach, and then, at Jasc's option, Jasc
shall either: (a) return the price you paid (if any) for the Software Product (at which time your rights under
this EULA are deemed to have terminated); or (b) repair or replace the Software Product. The Limited
Warranty period for any replacement Software Product will be extended for the remainder of the original
warranty period or thirty (30) days after the replacement Software Product is delivered to you, whichever
is longer. If your license is for an Evaluation Version, your exclusive remedy for any breach of this EULA,
including a breach of the Limited Warranty, shall be to terminate your rights under this EULA. Your
remedies described in this paragraph are your exclusive remedies, and shall not be deemed to fail of their
essential purpose so long as Jasc is willing to repair or replace the Software Product or return the price
you paid for the Software Product.

LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL JASC
OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF
OR INABILITY TO USE THE SOFTWARE PRODUCT, EVEN IF JASC HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. IN ANY CASE, JASC'S ENTIRE LIABILITY UNDER ANY PROVISION OF THIS EULA SHALL BE LIMITED TO
THE GREATER OF THE AMOUNT ACTUALLY PAID BY YOU FOR THE SOFTWARE PRODUCT OR US$5.00. Some
states do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you.

STATEMENT CONCERNING U.S. GOVERNMENT USERS. The Software Product is commercial computer
software developed exclusively at private expense, and in all respects is proprietary data belonging to
Jasc or its suppliers. The Software Product is comprised of “commercial computer software” and
“commercial computer software documentation” as such terms are used in 48 C.F.R § 12.212. Consistent
with 48 C.F.R. § 12.212 and 48 C.F.R. § 227.7202-1 through § 227.7202-4, all U.S. Government
licensees acquire the Software Product with only those rights set forth in this EULA.

SITE LICENSES. The owner of the computer that you are installing the Software Product upon may have
entered into a broad license agreement with Jasc governing the use of certain Jasc products including
this Software Product. To the extent that the owner of the computer has entered into such an agreement
that specifically states that it governs the use of the Software Product on computers owned by the owner,
then any conflict between that agreement and this EULA shall be resolved in favor of the terms of that
agreement, but otherwise this EULA shall simultaneously govern your license to the Software Product.

THIRD PARTY WORKS. To the extent that any third party's intellectual property is incorporated within the
Software Product, you agree that such third party is a third-party beneficiary of the terms of this EULA to
the extent of the third party's license to Jasc.

SAMPLES. The Software Product may be provided with certain "Sample Forms" intended to demonstrate
use of the Software Product or provide a base starting point for use of the Software Product. Sample
Forms includes forms, templates, Paint Shop Pro "tubes”, or similar items. If Sample Forms are provided,
they are considered part of the Software Product for purposes of this EULA. However, you may use and
create derivative works from Sample Forms, provided that you do so in conjunction with your use of the
Software Product, and that you maintain any copyright notices that may be incorporated within the
Sample Forms.

GENERAL. This EULA constitutes the entire agreement between you and Jasc concerning the Software
Product. No terms of any purchase order, acceptance, purported amendment, or any document or



communication other than an agreement expressly agreed upon in writing by a duly authorised officer of
Jasc shall replace, modify, amend or override this EULA. If any provision of this EULA is held to be
unenforceable for any reason, such provision shall be reformed only to the extent necessary to make it
enforceable, and such decision shall not affect the enforceability of such provision under other
circumstances, or of the remaining provisions hereof under all circumstances. No waiver by Jasc of any
breach of any term or provision of this EULA shall be construed to be a waiver of any preceding or
succeeding breach of the same or any other term or provision hereof. Our various rights and remedies
hereunder shall be construed to be cumulative and no one of them is exclusive of any other or of any right
or remedy allowed by law or in equity. This EULA shall be governed by and construed in accordance with
the laws of the State of Minnesota, USA (without regard to its choice of law principles), except to the
extent the local law of your local jurisdiction requires use of your local jurisdiction's law, and shall benefit
Jasc, its successors and assigns. ANY CLAIM OR DISPUTE BETWEEN YOU AND JASC OR AGAINST ANY AGENT,
EMPLOYEE, SUCCESSOR OR ASSIGNEE OF JASC, WHETHER RELATED TO THIS AGREEMENT OR OTHERWISE, AND
ANY CLAIM OR DISPUTE RELATED TO THIS AGREEMENT OR THE RELATIONSHIP OR DUTIES CONTEMPLATED UNDER
THIS AGREEMENT, INCLUDING THE VALIDITY OF THIS ARBITRATION CLAUSE, SHALL BE RESOLVED BY BINDING
ARBITRATION BY THE NATIONAL ARBITRATION FORUM TO BE HELD IN MINNEAPOLIS, MINNESOTA UNDER ITS
CODE OF PROCEDURE THEN IN EFFECT. Any award of the arbitrator(s) may be entered as a judgment in any
court of competent jurisdiction. Except as may be required by law, neither a party nor an arbitrator may
disclose the existence, content, or results of any arbitration hereunder without the prior written consent of
both parties. Information concerning such arbitration may be obtained, and claims may be filed, at any
office of the National Arbitration Forum or at P.O. Box 50191, Minneapolis, MN 55405. The United Nations
Convention on Contracts for the International Sale of Goods shall not apply to this EULA. Should you
have any questions concerning this EULA, or if you desire to contact Jasc for any reason, please contact:
Customer Service, Jasc Software, Inc., 7905 Fuller Road, Eden Prairie, MN 55344 USA/Telephone: (952)
930-9800/Facsimile: (952) 930-9172/E-mail: customer.service@jasc.com

Acknowledgments

BY USING THE TRY & BUY VERSION OF PAINT SHOP PRO, YOU ACKNOWLEDGE THAT YOU HAVE
READ THIS LIMITED WARRANTY, UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS
AND CONDITIONS. YOU ALSO AGREE THAT THE LIMITED WARRANTY IS THE COMPLETE AND
EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER OF THE LIMITED WARRANTY.

JASC SOFTWARE, INC. HAS SECURED AN AGREEMENT WITH UNISYS TO USE THEIR PATENTED
LZW COMPRESSION TECHNOLOGY IN THE TIFF AND GIF IMAGE FILE FORMATS. THIS
AGREEMENT COVERS THE EVALUATION, TRY & BUY AND LICENSED VERSIONS OF JASC
PRODUCTS. BY USING JASC PRODUCTS YOU ARE ASSURED OF BEING IN COMPLIANCE WITH
UNISYS' LZW PATENT.

OUR AGREEMENT WITH UNISYS REQUIRES THE FOLLOWING STATEMENT TO BE INCLUDED
WITH ALL EVALUATION AND TRY & BUY VERSIONS. PLEASE NOTE THAT ALTHOUGH PARAGRAPH
2 STATES THAT OUR PRODUCTS CAN NOT BE USED FROM A NETWORK SERVER, THE
AGREEMENT THAT JASC HAS SECURED WITH UNISYS WILL (I REPEAT, WILL) ALLOW YOU TO
OPERATE THE LICENSED VERSION ON YOUR NETWORK SERVER PROVIDED YOU HAVE
PURCHASED A SITE LICENSE.

1. Use of this software is permitted only to the extent reasonably required to determine whether to
purchase the software.

2. After payment is made, use of this software is limited to use on only a single personal computer or
workstation which is not used as a server. An additional payment is required for each use on another
personal computer or workstation.

3. Only a single copy may be made of this software solely for backup or archival purposes. The
software may also be transferred to a single hard disk.

4. Any use of this software in violation of the above is not licensed.



5. For information concerning licensing the LZW compression and/or decompression capability, please
contact:

Unisys Corporation

Welch Licensing Department - C1SW19
Township Line & Union Meeting Roads
P.O. Box 500

Blue Bell, Pennsylvania 19424

Microsoft, Windows, and Windows NT are either trademarks or registered trademarks of Microsoft
Corporation in the United States and/or other countries.

This product utilizes one or more of the following patents owned by Digimarc Corporation. U.S. Patents
#5,636,292, 5,710,834, 5,721,788, 5,745,604, 5,748,763, 5,748,783, 5,768,426, 5,809,160, 5,832,119,
5,841,978, 5,850,481 and 5,930,377.

©2001 Jasc Software, Inc. All rights reserved. All other trademarks and registered trademarks are the
sole property of their respective owners.



